Inventor (10) Module 1G: 1G- 1

Creating A Circle-Based Cylindrical Sheet-metal Lateral Piece with An Overlaying Lateral Edge Seam
And Dove-Tail Seams on The Top Edge

Module 1G:
Creating a Circle-Based Cylindrical Sheet-metal
Lateral Piece with an Overlaying Lateral Edge Seam
And Dove-Tail Seams on the Top Edge

In Module 1A, we have explored the method of creating a cylindrical sheet metal
part using the Revolve tool; with this method, a tiny gap is created along the seams of the
lateral piece. In practical design, this method is suitable for situations where the folded-
up lateral piece is to be welded (Figure 1G-1A); however, there are occasionally
situations where the folded-up lateral piece is to be connected by an overlapping seam
(Figure 1G-1B). In this Module, we will learn how to create a cylindrical sheet metal
lateral piece with the Contour Flange tool. In addition, we will explore a “work-around”
method of creating dove-tail seams on the top edge of the lateral piece.

Figure 1G-1A: The tiny gap is created
along the seams of the lateral piece when

the creating a cylindrical sheet metal part  Figure 1G-1B: The overlapping Seam.
using the Revolve tool.

b

Step 1: Construct the circular base profile with an overlapping seam

First, we will create a sheet metal file with inch as units. Launch Autodesk
Inventor. Create a new sheet metal file (go to the menu File->New, or click on the New
icon on Standard Tool Bar. The Open window appears. Select the English tab; then
select the Sheet Metal (In).ipt template, click OK button (Figure 1G-2A).
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A new sheet metal file opens with two panels docked on the left side of the
screen: 2D Sketch (top) and Model (bottom). The Sketchl opens automatically on the
screen; and Sketchl feature appears on the Model panel. Click the Return key in the
Inventor Standard tool bar (Figure 1G-2B) to dismiss the Sketchl feature.

In the Model panel, click the cross on the left of the Origin folder to view the
Planes, Axis and Center Point features; click-select the Sketchl feature and right-click
for the shortcut menu and choose the Delete option to delete it (Figure 1G-2C). Next, go
to the View—>Isometric menu to switch to an isometric view (Figure 1G-2D). Next,
select the XZ Plane, then right-click to open the short cut menu and check the Visibility
option (Figure 1G-2E). Next, click-select the XZ Plane and then the Sketch button on
the Inventor Standard tool bar to start a new sketch (Figure 1G-1F); Sketch2 feature
appears in the Model panel; highlight the Sketch2 name and type Base Profile to rename
the feature.

Next, click-select the XZ Plane and then the Look At tool button in the Inventor
Standard tool bar (Figure 1G-2G, left) to switch to an orthographic normal view (Figure
1G-2G, right). Now, we are ready to start the elliptical base profile.

Click-select the Project Geometry tool from the 2D Sketch tool panel and then
the Center Point from the Model panel to project it onto the Base Profile Sketch; a
green dot appears on the center of the Base Profile Sketch; next, select the Center Point
Circle tool from the 2D Sketch tool panel and create a horizontal line starting from the
projected Center Point; use the General Dimensions tool to apply a 24-inch diameter
dimension (Figure 1G-3A). Next, use the Line tool to create a horizontal line starting at
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the projected Center Point and ending at a convenient location on the right of the circle;
and right-click for the shortcut menu and choose the Restart option (Figure 1G-3B) to
create another horizontal line starting at the projected Center Point and ending at a
convenient location on the left of the circle (Figure 1G-3C); next, select the Trim tool to
trim off the lower half of the circle (Figure 1G-3D); right-click for the shortcut menu and
choose Done [Esc] option to exit the tool (Figure 1G-3E).
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Figure IH-2G: Selecting the XZ Plane and clicking the
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Figure 1G-3A: Creating
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Figure 1G-3B: Creating a horizontal line
starting at the projected Center Point and
ending at a convenient location on the right of
the circle; and selecting the Restart option to
create a new line.

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (10) Module 1G: 1G- 5
Creating A Circle-Based Cylindrical Sheet-metal Lateral Piece with An Overlaying Lateral Edge Seam
And Dove-Tail Seams on The Top Edge

X

2D Sketch Panel ~
: 2D Sketch Panel =
/ Line L ~
| [ MoTrim X

Figure 1G-3C: Creating the other |
horizontal line. Figure 1G-3D: trimming off the lower

half of the circle.
f 24,000

-

Extend

v Trim
2D Sketch Panel
+] Previous Yisw FS

SR Trim X Isometric Yiew Fé

How To...

Figure 1G-3E: Exiting the tool.

Next, select the left horizontal line and press the Delete key on the keyboard to
delete it (Figure 1G-3E). Next, select the General Dimension tool to apply a 0.066-inch
(half of the thickness of the sheet-metal material plus a 0.001-inch gap allowance, or
0.120 +~ 2 + 0.001 = 0.066) linear dimension to the short line (Figure IH-3F).
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left horizontal line.

Figure I1G-3F: Applying a 0.065-inch
linear dimension to the short line.
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Figure 1G-3G: Clicking once at the right button to view the entire circle and
endpoint of the short line (point A) segment  clicking the left endpoint of the
to establish the center of the circle. circular arc to establish the radius of

the “overlapping circle.”

Next, use the Zoom Window tool to zoom in the area enclosing the 0.066-inch
short line segment; select the Center Point Circle tool; click once at the right endpoint
of the short line segment to establish the center of the circle, at the appearance of the
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green dot endpoint snap indicator (Figure 1G-3G); click the Zoom All tool button on the
Inventor Standard toolbar so as to view the entire circle (Figure 1G-3H), and click once
at the left endpoint of the circular arc to establish the radius of the circle (Figure 1G-3H).
Next, select the Center Point Circle tool and create a circle to establish the width of the
overlapping seam; select the General Dimension tool to apply a 2.00-inch diameter
dimension (corresponding to approximately 1.00-inch of the intended width for the
overlapping seam (Figure 1G-3J). Next, select the Trim tool to trim off the upper half of
the “overlapping circle” (Figure 1G-3K).
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Figure 1G-3J (left): Creating the *““seam width™
construction circle.
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Figure 1G-3M: Switching to an isometric
view with the View ->Isometric menu.

The profile of the cylindrical sheet-metal piece with overlapping seam is
complete. Click the Return button on the Inventor Standard tool bar to exit the Sketch
mode. Next, go to the View-> Isometric menu to switch to an isometric view (Figure 1G-
3M). In the Model panel, select the Sketch1l feature, highlight the name and retype Base
Profile to rename it. Now, start saving the file. Press Ctrl and s keys simultaneously to
save the file as Tut- Cylinder with Overlapping Seam.ipt with Part File (*ipt) for Save
As Type field, in a convenient directory location, in a new folder to be created and
named Tut-Cylinder with Overlapping Seam in the Save As window in a convenient
directory location (Figure 1G-3N through Figure 1G-3Q). Save often, at least at the end
of each step.
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Step 2: Create the circular cylindrical sheet-metal lateral piece
with an overlapping seam

Next, switch to the Sheet metal Features tool panel and select the Contour
Flange tool; click the Profile button in the tool’s dialog window and click-select the open
circular profile on the screen; the green geometry outlines of the Contour Flange
appears on the screen (Figure 1G-4A); use the Zoom Window tool to zoom in the area
with the overlapping seam as shown in Figure 1G-4B; click the Offset button in the
tool’s dialog window so that the Contour Flange’s points inward (Figure 1G-4B); click
the OK button to create the Contour Flange feature, and rename it Cylinder in the
Model panel. Select the XZ Plane on the screen and right-click for the shortcut menu to
uncheck the Visibility option; the XZ Plane disappears from view (Figure 1G-4C). Next,
select the Rotate tool and rotate the model to a convenient location where the
overlapping seam can be easily seen (Figure 1G-4D).

Contour Flange E@
Shape | Linfold Opticee: | Relef Options |
Shape Bend
e -
| i BendRadus ]
| offsat A
Exterts yd ™
Type i b
I = 24,000—+ >(”‘*3r
e[ @] 7 Figure 1G-4A:
— Click-selecting the
Sheet Metal Features ~ open circular profile
[* Contour Flange on the screen.

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (10) Module 1G: 1G-11

Creating A Circle-Based Cylindrical Sheet-metal Lateral Piece with An Overlaying Lateral Edge Seam
And Dove-Tail Seams on The Top Edge

Contour Flange

Shape l Unfold Options ] Relief Options ]

Shape Bend
le | Profile Radius
Bendradius »
Edge

’? Off set H

@ OK | Cancel | ﬂ -
Extents /
Type
| 7] /
Distance
Eran| s ]

Figure 1G-4B:
Clicking the Offset

button in the tool’s
Sheet Metal Features ~ dialog window so that

| (% Contour Flange the_ Coptour Flange’s
7/ points inward.

Next, select the Corner Chamfer tool; click the Corner button in the tool’s
dialog window and then the front and rear end corners of the overlapping seam; red
geometry outlines for the Corner Chamfer features appears on the screen (Figure 1G-
5A); click the OK button to create the Corner Chamfer features (Figure 1G-5B), and
rename them Seam Corner Chamfers in the Model panel.

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (10) Module 1G: 1G-12

Creating A Circle-Based Cylindrical Sheet-metal Lateral Piece with An Overlaying Lateral Edge Seam
And Dove-Tail Seams on The Top Edge

o

Fotate]

Copy Chrl+C

& mew Sketch

Create Mote

<

L i
v
Look At Page Up
Fird in Browser
E Previous View FS

Auto-Resize

]
Figure 1G-4D: Rotating the model.

Isometric View F&

How Ta... Sheet Metal Features »

] @' Contour Flange

Figure 1G-4C: Un-checking the
Visibility of the XZ Plane.

Sheet Metal Features ~
% I [ Corner Chamfer

Corner Chamfer

Distance
% | Corners 0‘75““ ¥ I
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Figure 1G-5B: The Corner Chamfers.

Next, go to the View-> Isometric pull-down menu to switch to an isometric view
(Figure 1G-5C); next, click-select the outer surface of the folded-up model and click the
Flat Pattern tool button in the Sheet Metal Features to create the Flat Pattern view
(Figure 1G-D). The Flat Pattern view window opens; close the Flat Pattern window so
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as to return to the 3D model screen by clicking the lower X box at the upper-right corner
of the screen (Figure 1G-E).
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© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (10) Module 1G: 1G-14

Creating A Circle-Based Cylindrical Sheet-metal Lateral Piece with An Overlaying Lateral Edge Seam
And Dove-Tail Seams on The Top Edge

Step 3: Creating the dove-tail seams on the top edge of the cylindrical sheet-metal
lateral piece with a “work-around” method

We will now create dove-tail seams on the top edge of the cylindrical sheet-metal
lateral piece with a “work-around” method. Since Inventor cannot create Flange features
(the seams with the appropriate Bend features) on a curved surface (the surface of the
lateral piece of the cylindrical sheet-metal part, we will use the Extrude tool to create
“standing-up” seams without the appropriate Bend features, as a “work-around” method.
Although the dive-tail seams so created are not bent as they should be, bends can be
made in the fabrication process.

First, select the Zoom Window tool to zoom in any convenient portion of the top
surface of the lateral piece so that the surface can be click-selected; click-select the top
surface and then the Sketch tool button to start a new Sketch feature, as shown in Figure
1G-5A, and rename it Dove Tail Seam Profile in the Model panel; next, click the Look
At button on the Inventor Standard tool bar and then the Dove Tail Seam Profile
Sketch feature to switch to an orthographic normal view (Figure 1G-5B). Notice that the
edges of the top edge surface are automatically projected onto the new Sketch feature
when started, by Inventor’s default settings; window-select the projected outlines, and
press the Delete key on the keyboard to delete them. Next, select the Project Geometry
tool and select the Center Point feature from the Model panel to project it onto the Dove
Tail Seam Profile Sketch feature. Next, select the Line tool and create a vertical line and
an inclined line, both starting from the projected Center Point (Figure 1G-5C).

. J‘__.-—-“‘”_'_F [ H‘"‘Hu__um. 2D Sketch Parﬂ -
Sline L ~

_it} Look At (Page Up)| |

-
~
e
P i,
[
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Figure 1G-5B: Switching to an Figure 1G-5C: Creating a vertical line

orthographic normal view. and an inclined line.
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Next, graphically determine the approximate inner angle of a slice of the circle
enclosed by the outer circular edge of the cylindrical sheet-metal part, for the cord length
(the dove-tail width) to be approximately 1.00 inch. Select the Center Point Circle tool
to create a circle centered at the approximate point of intersection between the vertical
line and the outer circular edge of the cylindrical sheet-metal part, and use the General
Dimension tool to apply a 2.00-inch diameter dimension to the circle (the “dove-tail
seam width construction circle,” corresponding to twice the intended 1.00-inch width for
the dove-tail seams; Figure 1G-5D); next, applying a angular dimension to the vertical
and inclined lines; the default measured value indicate that the angle is 9.08° and its two
points of intersection with the outer edge of the cylindrical sheet-metal part forms a cord
with a length twice as large as the radius of the “dove-tail seam width construction
circle;” therefore, type 5 deg in the General Dimension tool’s text field and click the
green checkmark (Figure 1G-5E); the inclined line now appears to be tangent to the
“dove-tail seam width construction circle” (Figure 1G-5F). Therefore, the inner angle is
approximately 5°. The alternative mathematical method can be used to determine the
inner angle of the slice of the circle enclosed by the outer circular edge of the cylindrical
sheet-metal part, for the dove-tail width to be an intended value:

Circumferance; . = Diameterg; . x 7 = 24.0x3.14 = 75.4in

Circle

Number, . = Clrcu_mferanceCircle _ 75.4_|n ~75
Widthp e il 1.00in
Seam
Angleinner = AngIeCirde = 360 =4.8°~5.0°

Number, 75

Slice
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Figure 1G-5E: Applying an angular
dimension.

Figure 1G-5D: Creating the 2.00-inch
diameter “dove-tail seam width construction
circle” centered at the approximate point of
intersection between the vertical line and the
outer circular edge of the cylindrical sheet-
metal part.

Next, select the Project Geometry tool and click-select the inner and outer edges
of the sheet-metal part to project them onto the sketch. Next, select the inclined line and
the “dove-tail seam width construction circle” and press the Delete key on the keyboard
to delete them (Figure 1G-5F). Next, select the Trim tool to trim off the excessive
segment of the vertical line (Figure 1G-5G). Next, select the Circular Pattern tool; click
the Geometry button in the tool’s dialog window, and click-select the vertical line
(Figure 1G-5H); click the arrow button on the left of the Axis button in the tool’s dialog
window, and click-select the center point of the circle (lower endpoint of the vertical line)
(Figure 1G-5J); the Circular Pattern geometry appears on the screen (Figure 1G-5K);
type 360/5 for number of Instances of the Circular Pattern in the tool’s dialog window
(Figure 1G-5L); click the OK button to create the Circular Pattern 2D sketch feature
(Figure 1G-5M).

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (10) Module 1G: 1G-17
Creating A Circle-Based Cylindrical Sheet-metal Lateral Piece with An Overlaying Lateral Edge Seam
And Dove-Tail Seams on The Top Edge

\
2D Sketch Panel ~ ||

1

MTrim X :
I

.
L

/ 2D Sketch Panel ~ Figure 1G-5G: Trimming the
Outer Edge 2 broject Geometry ~ excessive segment of the vertical line.

Inner Edge
P

/ 2D Sketch Panel »

< General Dimension D

Figure 1G-5F: The inclined line appearing
to be tangent to the “dove-tail seam width
construction circle;” selecting and deleting
the inclined line and the ““dove-tail seam
width construction circle;” and projecting
the inner and outer edges of the sheet-metal
part onto the sketch.
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Figure 1G-5J: Selecting the center
point of the circle (lower endpoint of
the vertical line) for Axis.
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Figure 1G-5L: Typing 360/5 for number
of Instances of the Circular Pattern.

Next, use the Zoom Window tool to zoom in a reasonably sized area of the top
edge surface; select the Trim tool to trim off pairs of arc segments for the gaps between
the dove-tail seams (Figure 1G-5N); hold the middle button of the mouse and drag to pan
to next areas when needed; when finished, right-click for the shortcut menu and choose
the Done option to exit the tool (Figure 1G-5P).
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Figure 1G-5M: The Circular Pattern 2D
sketch feature.

Extend
v Trim

2D Sketch Panel ~ |
i
HoTrim ¥

Zoom Window (Shift+F3)

Figure 1G-5N: Trimming off pairs of arc

segments for the gaps between the dove-tail
seams.
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Figure 1G-5Q: Window-selecting all
radiating Circular Pattern lines
starting from a lower right corner

Figure 1G-5P; Right-clicking for the shortcut ~ @nd ending at an upper left corner.
menu and choose the Done option to exit the
Trim tool after completing all gaps between the

dove-tail seams.
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P
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Figure 1G-5S: Changing
the line Style of radiating
Circular Pattern lines to
Construction.

Figure 1G-5R: All radiating
Circular Pattern lines
selected.

Next, window-selecting all radiating Circular Pattern lines starting from a lower
right corner and ending at an upper left corner (Figure 1G-5Q and Figure 1G-5R); click
the Construction button on the Inventor Standard tool bar to change their line Style to
Construction (Figure 1G-5S). Next, select the Line tool to add short edges to the dove-
tail seams’ closed profile, click at the appearance of green dot endpoint snap indicators to
make sure that the profiles are closed (Figure 1G-5T). Click the Return button to exit the
sketch. Go to the View—> Isometric menu to switch to an isometric view.

2D Sketch Panel * Autodesk Inventor Professional 10.0 - NOT FOR RESALE - [Tut-Cylinder|
_/Line L - J@ File Edit View Insert Format Tools Conwvert Applications ‘Window Web Help
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Figure 1G-5T: Using the f;:;“:fsﬁm
Line tool to add short edges e
to the dove-tail seams’ [ Corner Round

closed profiles. D Corner Chanfer

? PunchTool

Figure 1G-6A: Switching to an isometric view,
and to the Part Features tool panel.
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Figure 1G-6B: Creating the dove-tail seams.

Next, switch to the Part Features tool panel from the Sheet Metal Features tool
panel by clicking the downwardly-pointing triangle next to the name and choosing the
Part Features option from the pull-down menu (Figure 1G-6A). Next, select the
Extrude tool; click the Profile arrow button in the tool’s dialog window and then click-
select the closed profiles for dove-tail seams, with the help of the Zoom Window tool if
needed; select Distance for Extents and type 1 in (inch) in the text field, click the
leftmost Direction button so that the dove-tail seams; green geometry outlines point
upward; click the OK button to create the dove-tail seams (Figure 1G-6B); and rename
the Extrude feature Dove Tail Seams in the Model panel.

Next, switch to the Sheet Metal Features tool panel; click-select the frontal outer
surface of the lateral piece and click the Flat Pattern tool button to create the Flat
Pattern view (Figure 1G-6C). If desirable, apple a colorful material rendering by
selecting a material type from the pull-down menu on the Inventor Standard tool bar in
the Flat Pattern window; the folded-up 3D model window automatically updates
(Figure 1G-6D). Save the file. The features of the sheet-metal part are listed in the Model
panel (Figure 1G-6F).
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Figure 1G-6C: Creating the Flat Pattern view.
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Figure 1G-6D: Applying an Aluminum (Polished) material Figure 1G-6E: The

T . folde-up3D model
rendering in the Flat Pattern window. window automatically

updating to the
assigned material
rendering.

Congratulations! In this Module, you have learned how to create a cylindrical
sheet-metal part with an overlapping seam on its lateral edge and dove-tail seams on its
top edge, and its Flat Pattern view.
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Figure 1G-6F: The Model panel feature list.

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



	Module 1G:
	Creating a Circle-Based Cylindrical Sheet-metal
	Lateral Piece with an Overlaying Lateral Edge Seam 
	And Dove-Tail Seams on the Top Edge
	Step 1: Construct the circular base profile with an overlapping seam


